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LabSolutions IR
Report Template Creation Procedures

In the infrared spectrophotometer control workstation LabSolutions IR, more functions have been added and 
improved in comparison to previous control software IRsolution, making it easier to use. One of these is the report 
template function. This function allows the user to freely edit the report output items and the layout. This article 
will introduce the report template creation procedures and registration procedures.

The LabSolutions IR report template function is used 
to create templates for arranging and printing 
measurement data graphs, parameters, spectral 
search results, and other information in the [Report] 
window for printing output results. With 
LabSolutions IR, numerous report templates are 
provided as standard. However, users can also create 
report templates to suit their objectives and  in 
formats that are easier to understand.
The templates created can be saved as report 
template �les. A particular template can be speci�ed 
for printing, and printing can be linked with the 
LabSolutions IR windows.

1. Report Templates

The LabSolutions IR report template function re�ects 
the following improvements in comparison to 
IRsolution. 
The printing results can be edited with the images as 
is. (See Fig. 1.) 
When arranging items in the [Edit Printform] 
window with IRsolution, only the frame is displayed, 
not the actual graph (Fig. 1 (a) View|Graph), and the 
character string "$(IRSpectrum|Created)" is displayed 
in place of the date and time item, rather than the 
content actually printed. In contrast, with 
LabSolutions IR, the actual graph waveform and the 
actual date and time are displayed. As a result, it 
takes less time to check the layout and make �ne 
adjustments to the item arrangement.

2. Improvements from IRsolution

3. Items Can Be Edited 
    in the Report Template Editing Window

For text output items such as (1), (2), and (6), 
right-click the item, and click [Edit Mode] on the 
menu to add text as you wish. (See Fig. 4.)  For 
example, with the item (1) [Date&Time], only the date 
and time are output, so you can add the text "Print 
Date" before the date and time to clarify the 
meaning. (See Fig. 4.)  You can also edit the font type, 
the style, or the size by clicking [Edit Mode].

Source] setting. By default, the spectral data on the 
active tab, i.e. the tab that is active in the display 
window, is set as the source.
For graph display items as in (3), you can show or hide 
the grid, or set the X-axis range in the [Property] 
window. The graph line color and thickness settings 
are re�ected by those in the display window, so to 
edit them, right-click the graph in the display 
window, and on the displayed menu, click [Graph 
Preferences]. Note that to acquire a graph as an 
image, click [Copy] on the [Edit] menu to copy the 
graph image to the clipboard.

This section describes the procedures for creating a 
report template for printing peak detection results. 
As prerequisites, the spectral data �le must already 
be opened, and peak detection must have been 
implemented.
First, to edit the report template, open the [Edit 
Printform] window. To display the [Edit Printform] 
window, click the [Edit Printform] tab on the main 

4. Basic Report Template Creation

In the report template editing window, the printing 
layout can be edited by dragging graphs, peak tables, 
and other required items into the [Report] window. 
(See Fig. 2.)  Items can be consolidated one by one, or 
you can click the +  icon to the left of an item to 
display an expanded view of the items included 
therein.
In addition to changing the position and size of items 
in the [Report] window, you can con�gure the 
characteristic settings for each item in the [Property] 
window. For example, for the spectral graph item, 
you can show or hide the grid, and specify the items 
for the X-axis range.

Fig. 2  Adding Items

Fig. 1  The [Edit Printform] Window Display

Fig. 3  The [Edit Printform] Window

Fig. 4  Adding Text

toolbar in the LabSolutions IR postrun analysis 
program or the measurement program.
Next, drag and drop the items to output in the 
report from the [Item] window to the [Report] 
window. Here, I have selected (1) [Date&Time] and 
(2) [User Name] from the [System] category, (3) 
[Graph], (4) [Peak Pick Table], and (5) [Scan 
Parameter] from the [View] category, and (6) 
[Filename] from the [Property] – [Spectrum] category. 
(See Fig. 3.)
When an item is activated by clicking it, the 
con�gurable settings are displayed in the [Property] 
window. The item properties include the [Data 
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Utilizing User Libraries

Libraries (databases) are indispensable for spectral searches. They are broadly classi	ed into two types: commercially 
available libraries and user libraries. Commercially available libraries (including those provided as standard with 
instruments) contain information on general substances and compounds. In contrast, user libraries are constructed by 
users themselves, so they can contain arbitrary IR spectra and information.
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IR spectra are speci	c to each substance, and are 
suitable for the qualitative analysis of organic 
substances. In this case, libraries are effective, but it 
should be noted that commercially available libraries 
differ by measurement method and category, and there 
are numerous options. In contrast, users can also create 
user libraries themselves.
For example, IR spectral peak intensities and wave 
number position are well known to differ depending on 
the measurement method. Specular re�ectance spectra 
can be converted into general absorption spectra using 
Kramers–Kronig analysis. Diffuse re�ectance spectra can 
be similarly converted using Kubelka–Munk conversion, 
and ATR spectra can be converted using ATR correction. 
If commercially available libraries are used, these 
corrections and conversions will be necessary if there is a 
difference between the measurement method in the 
library, and the measurement method for the IR spectra 
subject to search. However, if a user library is used, 
searches can proceed without corrections or conversions 
if the measurement method for the IR spectra subject to 
search is matched to the measurement method for the 
registered IR spectra.

2. Features of User Libraries and 
Commercially Available Libraries

Vol. 22, an earlier edition, introduced the use of 
difference spectra as an approach to spectral analysis. It 
was noted that difference spectra are effective for 
comparing small peak differences and for identifying 
contaminants. However, the use of user libraries is also 
an effective approach to spectral analysis. In this article, 
I will introduce their features and look at some actual 
examples.

1. Introduction

With the item (4) [Peak Pick Table], there is no item 
in the [Property] window specifying the peak No. to 
be output in the report. To output a speci	c peak 
only, select the unnecessary rows in the peak table in 
the [View] window. Click [Delete Peak] on the 
right-click menu. The rows deleted from the peak 
table will not be output in the report.
In terms of scan parameters, you can either select the 
[Scan Parameter] item from the [View] category as in 
(5), or select individual items from the scan 
parameters in the [Property] – [Scan Parameter] 
category. In the former case, scan parameters can be 
added in batch to a report, but there are many such 
scan parameters, so to select only the required items, 
click the button to the right of [Scan Parameter] in 
the [Data Options] area. A window will then be 
displayed for setting the items to print.
Only items with the corresponding checkbox selected 
in the [Print] column in this window will be output in 
the report. (See Fig. 5.)  In the latter case, you can 
add the required parameters one at a time as 
individual items in the report.
When you have determined the item content and the 
layout, click [Save as] on the [File] menu. To print as 
is, click [Print Preview] on the [File] menu. Con�rm 
the print preview, and then click [Print].

The report templates introduced here can be created, 
edited, and registered with a series of intuitive 
operations, considerably improving the ease of use. 
Please use this function to create report templates to 
suit your analysis objectives and measurement data 
operations, thereby enhancing productivity.

7. Summary

To print a saved report template �le, click [Print with 
Template] on the [File] menu. Also, by clicking [Print 
Preferences] on the [Tool] menu, it is possible to link 
a default report template �le to printable windows. 
For example, in the default case, the report template 
"data_p.irtm" is allotted to the display window, but 
by changing this, you can avoid the trouble of 
clicking [Print with Template] each time.

5. Registering Report Templates

With LabSolutions IR, you can change the number of 
decimal places for measurement data for each item. 
(See Fig. 6.)
The procedure is as follows.
(1) If LabSolutions IR is running, exit it.
(2) Run LabSolutions Manager. (Log in to 

LabSolutions with administrator rights.)
(3) Click [Administration], point to [System Settings], 

and select [Data Proc. Settings].
(4) Set the number of decimal places for each data 

item.
(5) Exit LabSolutions Manager.

6. Changing the Number of Decimal Places

Fig. 5  Scan Parameters to Print

In addition, in spectral searches, a score (degree of 
similarity) is calculated from the shape of the IR spectrum 
as a whole. As a result, making determinations from the 
score alone will be dif�cult if the IR spectral differences 
are small. With commercially available libraries, it is not 
easy to distinguish the difference between low-density 
polyethylene and high-density polyethylene, or between 
ethylene-propylene block and random copolymers, 
because the difference between scores is small. However, 
with user libraries, even if the difference between scores 
is not large, detailed identi�cation and quali�cation can 
be performed by preregistering the library with relevant 
peak information.
When creating user libraries, sample acquisition and 
measurement conditions are indispensable, so time and 
effort are needed. However, when registering a sample 
serving as a foreign substance, for example, adding 
detailed information on the target substance including 
the sample name, part No., and place of use, may prove 
useful for investigations to determine the cause of 
foreign substance contamination.
In contrast, an advantage of commercially available 
libraries is that a large amount of data can be obtained 
without the effort involved in measuring them. However, 
they must be purchased, and only contain information 
on typical substances.
Also, most such libraries are associated with a particular 
brand, so analysis can be dif�cult if, for example, the 
spectral search involves a mixed spectrum. Also, in 
foreign substance analysis, even if qualitative and 
identi�cation information is obtained, separate 
investigation will be required to determine the cause (i.e. 
the origin of the foreign substance).
A comparison of user libraries and commercially available 
libraries (advantages and disadvantages) is summarized 
in Table 1.

Fig. 6  The Window for Changing the Number of Decimal Places
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Collect samples.

Measure the samples.

Instrument: IRAf	nity-1S, MIRacle10 (Diamond)
Resolution: 4.0 cm−1

Accumulation: 40
Apodizaion: Happ−Genzel
Detector: DLATGS

Create the library.

Register the IR spectra.
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Fig. 1  Foreign Substance IR Spectrum and Search Result, 
and Database Details

Material: Styrene butadiene styrene (SBS), 
 Calcium carbonate (CaCO3), 
 Magnesium silicate (TALC, 3Mg4SiO2H2O)

Major Elements: Cl, Ca, Si, Mg, S, Zn, Ti

Color: Gray

Form: Resin/Ring shaped

Hardness: Soft

Metallic Luster: No

Measurement Method: ATR (diamond)

Detailed Information on Search Result from an IR Spectral Database:
Packing for a drainage 	xture for a 32 mm dia. pipe_gray_interior

The procedures for creating a user library are 
summarized in Table 2.

Key points related to the creation of user libraries are 
noted above. To improve the accuracy of spectral 
searches, however, the quality of the IR spectra added 
to the library is also important.
Particularly for transmission measurements, be careful 

3. Procedures and Key Points When 
Creating User Libraries

This section describes a library for foreign substances in 
the water supply as a reference for creating a user 
library.
The library of foreign substances in the water supply is 
registered with the IR spectra for foreign substances 
actually collected, and commercially available water 
supply maintenance parts. Furthermore, it is also 
registered with element information obtained from 
analysis results using an energy dispersive X-ray 
�uorescence spectrometer (EDX). It is also possible to 
browse the details using the EDX pro�le database, 
which contains photographs of samples in addition to 
qualitative and quantitative information.
This section shows an example of the analysis of a 
foreign substance detected in the water supply using 
single re�ection ATR measurements. The measurement 
conditions in this case are shown in Table 3. The IR 
spectral search results are shown in Fig. 1. From the 
search results, it is evident that the foreign substance is 
quite similar to the packing for a drainage �xture.

that the maximum peak in absorbance does not exceed 
the range for which linear data can be obtained from 
the detector (normally an absorbance between about 0 
and 1). If this range is exceeded, the peak will plateau, 
and the peak height ratio will end up changing. Also, 
atmospheric correction is required for carbon dioxide, 
water vapor and other substances greatly affected by 
the air. During library registration, the values will be 
standardized automatically using the maximum value, so 
baseline correction is not required. However, but pay 
attention to the issues noted above to ensure that you 
create a high-quality library.
It is also recommended that you incorporate as much 
sample information as possible into user libraries as 
comments.

4. Introduction to a Library for Foreign 
Substances in the Water Supply

One disadvantage of spectral searches is the issue that 
unregistered substances will not produce a hit (because 
there will not be similar spectra). User libraries in 
particular only contain IR spectra registered by the user, 
so there are not many registered substances. Therefore, 
if unexpected substances are analyzed, they tend not to 
produce hits.
Furthermore, even if multiple similar spectra are 
identi�ed, signi�cant differences between the IR spectra 
are not always found. In such cases, if classi�cation is 
impossible using just the IR spectra, advanced searches 
supplemented with information other than the IR 
spectrum are effective.
Normally, specifying an unknown sample is a 
comprehensive assessment incorporating the sample's 
condition including form and color, as well as other 
information from analysis instruments.
The advanced search method combines spectral searches 
based on IR spectra with searches of text from other 
information.
Registering sample information in user libraries is very 
effective for this sort of application as well.

5. Effectiveness of Advanced Searches

There are many commercially available databases, more 
than 220,000 at present. Here, however, we have 
introduced the effectiveness of user libraries.
User libraries take considerable initial effort to create, 
but once they are created, they become important 
databases. It can also be effective to start by registering 
the samples you have at hand, and then registering the 
IR spectra frequently encountered in sequence as the 
need arises. We encourage you to create original 
databases to use in your daily procedures.

6. Summary

Table 1  Comparison of User Libraries and Commercially Available Libraries

User Libraries

Advantages

Disadvantages

Commercially Available Libraries

Inexpensive
Any data and information can be registered.
The cause of foreign substance contamination can be directly 
determined.

Large amounts of data can be obtained.
No measurements are required.

Samples must be acquired and measured.
�Effort is involved.
Not many substances are registered.

Expensive
Only typical substances are registered.
Only substance names and other typical information are 
contained.
�The causes of foreign substance contamination will remain 
unknown.

Table 2  Procedures for Creating User Libraries

Table 3  Instrument and Analysis Conditions

Stages of Creation Creation-Related Key Points

• Collect frequently analyzed samples and 
samples potentially subject to 
measurement (example: sources of foreign 
substance contamination).

• Acquire detailed sample information 
(material, color, form, hardness, 
presence/absence of metallic luster).

• Creating a different library for each 
measurement method and sample type 
makes selection easier during searches.

• Register the detailed sample information.

• Arrange the measurement method 
(transmission measurements, ATR 
measurements, etc.).

• Arrange the measurement conditions 
(apodization function, decomposition, etc.).

• If the components in the sample are 
non-uniform, more information is obtained 
by acquiring several spectra at different 
sites (example: the surface and cross section 
of rubber packing).

As shown here, the library for foreign substances in the 
water supply is a database summarizing actual foreign 
substances, so the search precision ratio is remarkably 
good. In addition to the qualitative results for the 
foreign material, it also has the advantage of providing 
information on color, form, hardness, presence/absence 
of metallic luster, and measurement method.
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Major Elements: Cl, Ca, Si, Mg, S, Zn, Ti
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The procedures for creating a user library are 
summarized in Table 2.

Key points related to the creation of user libraries are 
noted above. To improve the accuracy of spectral 
searches, however, the quality of the IR spectra added 
to the library is also important.
Particularly for transmission measurements, be careful 

3. Procedures and Key Points When 
Creating User Libraries

This section describes a library for foreign substances in 
the water supply as a reference for creating a user 
library.
The library of foreign substances in the water supply is 
registered with the IR spectra for foreign substances 
actually collected, and commercially available water 
supply maintenance parts. Furthermore, it is also 
registered with element information obtained from 
analysis results using an energy dispersive X-ray 
�uorescence spectrometer (EDX). It is also possible to 
browse the details using the EDX pro�le database, 
which contains photographs of samples in addition to 
qualitative and quantitative information.
This section shows an example of the analysis of a 
foreign substance detected in the water supply using 
single re�ection ATR measurements. The measurement 
conditions in this case are shown in Table 3. The IR 
spectral search results are shown in Fig. 1. From the 
search results, it is evident that the foreign substance is 
quite similar to the packing for a drainage �xture.

that the maximum peak in absorbance does not exceed 
the range for which linear data can be obtained from 
the detector (normally an absorbance between about 0 
and 1). If this range is exceeded, the peak will plateau, 
and the peak height ratio will end up changing. Also, 
atmospheric correction is required for carbon dioxide, 
water vapor and other substances greatly affected by 
the air. During library registration, the values will be 
standardized automatically using the maximum value, so 
baseline correction is not required. However, but pay 
attention to the issues noted above to ensure that you 
create a high-quality library.
It is also recommended that you incorporate as much 
sample information as possible into user libraries as 
comments.

4. Introduction to a Library for Foreign 
Substances in the Water Supply

One disadvantage of spectral searches is the issue that 
unregistered substances will not produce a hit (because 
there will not be similar spectra). User libraries in 
particular only contain IR spectra registered by the user, 
so there are not many registered substances. Therefore, 
if unexpected substances are analyzed, they tend not to 
produce hits.
Furthermore, even if multiple similar spectra are 
identi�ed, signi�cant differences between the IR spectra 
are not always found. In such cases, if classi�cation is 
impossible using just the IR spectra, advanced searches 
supplemented with information other than the IR 
spectrum are effective.
Normally, specifying an unknown sample is a 
comprehensive assessment incorporating the sample's 
condition including form and color, as well as other 
information from analysis instruments.
The advanced search method combines spectral searches 
based on IR spectra with searches of text from other 
information.
Registering sample information in user libraries is very 
effective for this sort of application as well.

5. Effectiveness of Advanced Searches

There are many commercially available databases, more 
than 220,000 at present. Here, however, we have 
introduced the effectiveness of user libraries.
User libraries take considerable initial effort to create, 
but once they are created, they become important 
databases. It can also be effective to start by registering 
the samples you have at hand, and then registering the 
IR spectra frequently encountered in sequence as the 
need arises. We encourage you to create original 
databases to use in your daily procedures.

6. Summary

Table 1  Comparison of User Libraries and Commercially Available Libraries

User Libraries

Advantages

Disadvantages

Commercially Available Libraries

Inexpensive
Any data and information can be registered.
The cause of foreign substance contamination can be directly 
determined.

Large amounts of data can be obtained.
No measurements are required.

Samples must be acquired and measured.
�Effort is involved.
Not many substances are registered.

Expensive
Only typical substances are registered.
Only substance names and other typical information are 
contained.
�The causes of foreign substance contamination will remain 
unknown.

Table 2  Procedures for Creating User Libraries

Table 3  Instrument and Analysis Conditions

Stages of Creation Creation-Related Key Points

• Collect frequently analyzed samples and 
samples potentially subject to 
measurement (example: sources of foreign 
substance contamination).

• Acquire detailed sample information 
(material, color, form, hardness, 
presence/absence of metallic luster).

• Creating a different library for each 
measurement method and sample type 
makes selection easier during searches.

• Register the detailed sample information.

• Arrange the measurement method 
(transmission measurements, ATR 
measurements, etc.).

• Arrange the measurement conditions 
(apodization function, decomposition, etc.).

• If the components in the sample are 
non-uniform, more information is obtained 
by acquiring several spectra at different 
sites (example: the surface and cross section 
of rubber packing).

As shown here, the library for foreign substances in the 
water supply is a database summarizing actual foreign 
substances, so the search precision ratio is remarkably 
good. In addition to the qualitative results for the 
foreign material, it also has the advantage of providing 
information on color, form, hardness, presence/absence 
of metallic luster, and measurement method.
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Corrected Height

Corrected Height = 2.486e-003 * Concentration + 1.083e-003. r = 0.9996

 1 −0.00015
 2 −0.00008
 3 0.00004
 4 0.00021
 5 0.00045
 6 0.00003
 7 0.00001
 8 −0.00011
 9 0.00061
 10 0.00059
 Standard deviation σ 0.000275

No.
Peak Height

 (Absorbance)

Table 1  Peak Height and Standard Deviation σ 
When a 0.0 % Concentration Standard Sample Is 

Repeatedly Measured Ten Times

Question

Answer

How are the lower limits of quantitation 
and the detection limits determined?

Fig. 1  Absorption Peaks for the Fatty Oil Standard Samples
(Enlarged View of 1600 to 1900 cm−1)

Fig. 2  Calibration Curve for Fatty Oil in Standard Samples

Note that the light absorption coef�cient differs with 
the substance being analyzed, so be aware that the 
calculated results for the lower limit of quantitation and 
detection limit will substance dependent.

The lower limit of 
quantitation and detection 
limit are the lower limit 

values for concentration that can be quanti�ed and 
detected. Generally, a blank sample is repeatedly 
measured. The concentration with respect to the 
absorbance at ten times the resulting standard deviation 
is taken as the lower limit of quantitation, and the 
concentration with respect to the absorbance at three 
times the standard deviation is taken as the detection 
limit1). As an example, the lower limit of quantitation 
and detection limit were obtained from the 
quantitation of fatty oil via the single re�ection ATR 
method introduced in Shimadzu Application News No. 
A468.
Standard samples of commercially available salad oil 
mixed with liquid paraf�n at 0.0, 5.0, 7.5, 10.0, 12.5, and 
15.0 % (w/w) concentrations were measured, and a 
calibration curve of the fatty oil was created. Fig. 1 
shows the absorption peaks for the fatty oil.
Refer to the Application News for the analysis conditions 
and other details. Fig. 2 shows the calibration curve 
created from the peak height in the vicinity of 1749 cm−1.
Table 1 shows the results of repeatedly measuring the 
0.0 % fatty oil standard sample as a blank sample ten 
times, and then determining the peak height, in a 
similar way as for the calibration curve. The standard 
deviation σ from the results of the ten repeated 
measurements was determined to be 0.000275.
The concentration corresponding to the 10 σ peak 
height is taken as the lower limit of quantitation, and 
the concentration corresponding to the 3 σ peak height 
is taken as the detection limit. Accordingly, from the 
formula for the calibration curve in Fig. 2, the lower 
limit of quantitation was determined to be 1.1 % and 
the detection limit was 0.33 %.

Lower limit of quantitation = 10 σ/Slope of the calibration curve
 = 10 * 0.000275/0.002486 = 1.1 %
Detection limit  = 3 σ/Slope of the calibration curve
 = 3 * 0.000275/0.002486 = 0.33 %

Reference:
1) Michihisa Uemoto, Bunseki (Analysis), May 2010.
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